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      Photo by Deborah Seibly 

 
ColorMunki – Have your photos submitted for QuickPix, Members’ Night, or competitions not looked the way you 

expected? The problem is probably a difference in how your computer and the club projector display colors and 

brightness. You can fix this by calibrating your computer the same way our club calibrates our projector – with the 

ColorMunki. Set up is simple and the calibration process only takes a few minutes. Contact Jim Selby at 

jim1423@earthlink.net  to reserve the ColorMunki. 
__________________________________________________________________________________________ 

Puppy and Kitty Portraits Help Shelter Pets Find New Homes 
 
 

 

RCC Member Debra Dorothy helps shelter pets find new homes by taking 
portraits of them. The photos of these furry creatures were taken at the Redlands 

Animal Shelter. If you would like to adopt an animal please call the Redlands 
Animal Shelter at 

(909) 798-7644 
 

                                   Want to learn more about your hobby?  
                        Click the link below to go to B&H learning Video Site: 

                                                      Click HERE

mailto:jim1423@earthlink.net
https://www.bhphotovideo.com/c/promotion/13486/optic-2017.html?utm_medium=Email%201654964&utm_campaign=Promotion&utm_source=WeeklySpecials%20170916&utm_content=Retail&utm_term=optic-2017
https://www.bhphotovideo.com/c/promotion/13486/optic-2017.html?utm_medium=Email%201654964&utm_campaign=Promotion&utm_source=WeeklySpecials%20170916&utm_content=Retail&utm_term=optic-2017
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Field Trips – Mary Ann Ponder  
 

 

August Field Trip 
 
 

Surf’s up! Let’s go to the beach! 
 

This month’s field trip is on Sunday, August 11th, departing from the downtown 

Riverside Metrolink station at 9:20AM and arriving at the San Clemente Pier at 

11:13AM.  

 

The return train departs San Clemente at 3:11PM and arrives in Riverside at 

5:08PM. For those who wish to have more time at the beach there is an additional train both in the 

morning and the afternoon. The fare is just $10 round trip. What a deal, huh? And you won’t have to 

cope with beach traffic on the freeway.  

 

For lunch you can eat at the restaurant on the pier, bring your own picnic or choose from any of many 

restaurants within walking distance from the pier. Remember that you’ll be carrying any camera and 

beach gear that you bring with you all day. Besides the beach front and downtown San Clemente, there 

are beautiful gardens open to the public at Casa Romantica.  

 

Please sign up in advance for this outing (and any club field trips) by contacting Mary me at 909-213-

5108 or e-mail maponder@yahoo.com so I will be looking for you at the Metrolink station located at 

4066 Vine Street in Riverside. No carpool is provided for this trip.  

 

 

 

 

 

 

 

 

 
Photo 

By 
Wayne Purcell 

 

 

 

 

 

 

 

mailto:maponder@yahoo.com
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Competition Chair – Carl Detrow 
 

 

Competitions 

 

Did You Get Your Ribbon? 

 

Once again thanks to all those who entered our summer 2019 competition and to all 

the members who helped out with the judging. We distributed the winning ribbons 

on July 15, but several winners were not there.  

 

If you were awarded a ribbon (check the web site to see if you did) but were unable to pick it up on the 

15th, it will be available at the next meeting, August 5. 

 

Our next competition will be Winter 2019 on December 2 with awards at our holiday banquet on 

December 16. Category X has still not been decided, so if you have a suggestion please let me know. 

 
Contact me by email:  csdetrow@verizon.net 

 

 

 

 

 

Photo 

by 

Mary Ann Ponder 

 

 

 

 

 

 

mailto:csdetrow@verizon.net
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Exhibits – Judith Sparhawk 

 
11th Annual Community Photoshow 

 

Redlands Art Association is again hosting its annual community photo show, from 

July 29th to August 4th.   

 

A reception will be held on Sunday, August 4th, from 2 – 4 pm. Bring friends and 

family to enjoy the show, have some refreshments, and meet other like-minded 

photographers. Your photographs may be taken home at the end of the 

reception. I hope members who do not have images in the show come to the reception in support of 

those who do. 

Call for Entries—Methodist Church Show 
We have again been invited to participate in a photo show at Redlands First Methodist Church. This has 

been a beautiful and fun show every year, and we are asking for entries for this year’s show which will 

run during September and October. 

   

Take in for prospective entries will be from 6 to 6:30 pm, prior to our regular meeting on August 5.  

 

The entries will be juried for the show, with a maximum of 20 accepted.  For jurying you may bring in up 

to 3 prints, 8x10 or larger; if you already have larger prints, framed or not, metal or canvas, please bring 

them for consideration. 

 

For those images that are selected, you will have three weeks to prepare your photos for hanging.  The 

room is large, and the larger your prints the better they will show up.  They will need to be frames at 

least to 16x20, larger is even better.  They need to be wired on the back for hanging, and identified on 

the back with your name, title of the piece, and price, if you are interested in selling.   

 

Take in of the framed photos will be on Wednesday, August 28, 

10 am.  For questions, email me at  

             

                     mailto:jsparhawk746@yahoo.com.   

 

 

 
Photo 

by 
Stephanie Billings 

 

 

 

mailto:jsparhawk746@yahoo.com
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President – Dave Ficke 
 

 

Wow! It’s already August and summer is well underway. 
 

We had a great summer photo competition and a good turnout for the awards 

night, all good stuff.  As we prepare for our first meeting for August we are 

looking towards preparing for the glorious colors of fall this October.  

  

In lieu of having a survey this year, (and I am sure most are really bummed out 

about not having a survey!) During our meetings I have asked for suggestions 

as to how we can better serve our membership.  As of this writing, I have not 

had feedback from anyone.  So I might make a leap of faith and presume everyone just loves what we 

are doing and to keep it up!  BUT, just in case there is someone out there who has an idea, please let me 

know.   

 

As our SoCal summer continues through September and October, a few things to keep in mind for you 

and your camera as you travel through our desert climate with the summer monsoon season upon 

us.  For you, bring water, sunscreen, appropriate clothing, and watch the heat and how it is affecting 

you.   

 

For your camera you need to be thinking about condensation.  When you go from a nice, cool 

environment (your car with the AC on or your hotel room) to a hot humid outside environment, 

condensation can form inside your lens and camera.   

 

On the outside of your camera use a soft dry cloth; for the inside of your camera let the camera 

acclimate to the new environment slowly.  If you are traveling in a high humidity environment you might 

want to consider silica gel packets in your camera bag to absorb excess moisture.  

 

I know it is challenges at times, but if at all possible, do not store your camera in a hot car for long 

periods of time. Although I am not exactly sure how temperatures 

of 130+ degrees will affect the electronics of your camera, it can’t 

be good; I do know it has negative effects on me! 

 

Have a fun and safe summer.  

 

 
Photo 

by 
Jim Hendon 
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Mentor – Rick Strobaugh 

 

Framing the Shot 

 
You often hear the term, ―framing your shot‖ but what does that mean and when 

would you use it?  

 

Framing a photo will help create depth, simplify or focus the viewer's attention to 

where you want it.  

 

Usually, it is with something along the sides that then funnels your view into the main subject. It can also 

be a darker object surrounding a lighter colored, main subject. 

 

Another example would be looking out from within a cave or tunnel, to your main subject. Looking 

through a completely out of focus area to a subject that is in focus would do the same thing, attract 

immediate attention to the part of the photo that is in focus. 

 
       

 

 

 

 

 

        Photos by Rick Strobaugh 
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Member Recognitions 
 

I want to congratulate Christine Pence for her beautiful POTD win on Imaging Resource this month for 

her image ―Penguin Parenting‖ and also Mary Ann Ponder for her image ―Last Rays of the Day‖.  

 

This will put them up for a chance of winning POTM (Photo of the Month) and possibly winning a gift 

certificate for Adorama.  

 

Imaging Resource has great camera and photography related information and anyone can enter their 

Photo of the Day Contest, and if your photo is chosen for 1st 2nd or 3rd place for the month, you too can 

win a gift certificate from Adorama for $300, $200 or $100. 

 

 

 

 

 

 

 

 

Good luck ladies! 
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Here’s What I Think – John Williams 

 

This article covers different Adobe Photoshop/Lightroom 

procedures and techniques.  The views expressed in this 

article are those of the author and do not necessarily 

reflect the views of Redlands Camera Club. 

By John Williams 

Need help?  If you have any questions about processing an image using Adobe 

Lightroom or Photoshop, email me at jhwr@earthlink.net (for RCC members only) and I 

will try to assist you. 

DETERMINE YOUR WHITE BALANCE CORRRECTLY 

Using x-rite ColorChecker Classic to set your White Balance accurately: 

 Color management is all about getting your colors to match from input to output. That means that you need to 

consider the colors your camera captures, the way your monitor displays them, and how your printer produces a photo 

that is true to the original scene.  Every camera has its own interpretation of accurate color, and those colors can shift 

from manufacturer to manufacturer.  Your lens can impact color.  Cheaper lenses are notorious for slight shifts in color. 

 This article describes how to obtain a correct White Balance (WB).  To obtain an accurate WB, you should use X-rite 

ColorChecker and the software provided by X-rites to create a DNG profile to replicate accurate tones and color.  This 

way, you can be sure that your colors are accurate to what they look like in a portrait or landscape photograph.  

Normally you do not create a DNG profile unless you are required to have accurate colors such as in a commercial 

shoot. 

 The classic target (X-Rite ColorChecker Passport —$119) is the standard target for creating DNG profiles and quickly 

getting an accurate White Balance.  X-rite has recently introduced a larger target array, called ColorChecker  Classic 

(8.5‖ x 11‖).  You can use the ColorChecker Classic to create custom camera profiles (DNG) or quickly obtain a White 

Balance.  The x-rite  ColorChecker Classic target (https://www.xrite.com/categories/calibration-profiling/colorchecker-

classic  $80) is an array of 24 scientifically formulated colors.  Each of the 24 color patches represents the colors of 

natural objects, such as the blue sky, flesh tones and leaf green. Each patch reflects light just like its real-world 

counterpart. Because of its larger size, you can see the color patches easier. 

 
ColorChecker Passport                                                                ColorChecker Classic 

mailto:jhwr@earthlink.net
https://www.xrite.com/categories/calibration-profiling/colorchecker-classic
https://www.xrite.com/categories/calibration-profiling/colorchecker-classic
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 Be sure to shoot your photos in RAW:   Shooting in RAW provides you with greater flexibility to color-adjust your image.  

If you shoot your photos in JPEG mode, you will have significantly less ability to adjust your white balance.  RAW files 

also allow you to set the WB based on a broader range of color temperatures (Kelvin temperature scale) and green–

magenta shifts. 

 What is White Balance? Setting your White balance (WB) is the process of removing unrealistic color casts, so that 

objects which appear white are rendered white in your photo.  Proper camera WB has to take into account the "color 

temperature" of a light source, which refers to the relative warmth or coolness of white light.  Our eyes are very good at 

judging what is white under different light sources, but digital cameras often have great difficulty determining WBand 

the camera can create unsightly blue, orange, or even green color casts.   Light comes in many different qualities and 

colors.  Daylight can appear bluish or yellowish.  Artificial indoor lighting can range from a warm yellowish to a greenish 

hue.  However, since camera’s sees light literally, the white balance captured is based on averages, so they don’t 

necessarily represent the actual lighting you are shooting under.  You really shouldn’t rely on your camera’s auto white 

balance setting, as it can be misled by scenes that have more than average amounts of colors like red or blue in them. 

 The ColorChecker Classic White Balance Target:  The only way to get a consistent, neutral gray is to shoot with a proper 

gray reference.  You cannot white balance if any of the RGB values are at the maximum limit, with no tone value.  It is 

much easier to expose a light gray card so that the values are all very light, but not so light that they don’t have any 

tone.  A gray patch on the ColorChecker target will actually provide a more balanced neutral for JPEG and RAW 

photography.  The ColorChecker Classic White Balance target (red arrow in figure below) is produced to be a spectrally 

flat target, meaning it provides a neutral point of reference across the different types of lighting conditions. 

 

 Using the target to get an accurate white balance:  Simply shoot the target array in each new lighting condition.  

Normally when taking a portrait photo, the individual holds the target close to their face.  Then take the remaining 

photos in the same lighting conditions.  Open your photo in a processing software program (Lightroom or Photoshop).  

Select the Photoshop’s Camera Raw White Balance Tool (eyedropper–figure below) or Lightroom’sBasic Panel White 

Balance Selector (eyedropper–left figure below).  Then click on the bottom left color patch (red arrow in the figure 

above) for a neutral White Balance.  Keep an eye on the other color targets and click on the other adjacent targets (to 

the right of the first target) until you get a proper color in the other color targets.  If you are working in a RAW 

workflow, the custom white balance settings are non-destructive.  This means you can keep clicking and testing until 

you get the look you want.  If you aren’t happy with the results, you can always adjust the Temperature and Tint sliders 

in the Develop Module Basic panel. 
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Lightroom Classic (White Balance Selector)                                    Photoshop CC (White Balance Tool) 

LIGHTROOM CLASSIC TIPS 

When you have Lightroom Classic problems, recommended Troubleshooting steps: 

1. Reboot your computer:  Many times a restart will do magic in resolving problems. 

2. Optimize the Catalog:  In the menu bar, choose File>Optimize Catalog and click on the Optimize button in the popup 

window.  You can’t us Lightroom during the optimize operation. 

3. Check for Updates:  Make sure you’re running the latest Lightroom update.  Open your Adobe Creative Cloud app on 

your desktop.  Click on the three horizontal top icon (top right of workspace) and in the popup menu select Check for 

App Updates.  Install the latest Lightroom update to correct an issue with an earlier release.  Also check for updates to 

your Operating System and Graphic Processing Unit (GPU).  Also check for mouse or tablet drivers’ updates. 

4. Turn off the GPU:  You may have an older GPU or an older GPU driver.  If this helps then update your driver and turn 

the GPU on again to see if the problem is rectified. 

5. Reset Preferences:  Resetting Lightroom’s Preferences file can solve all sorts of problems, so it’s a good early step in 

troubleshooting.  You a reset your Lightroom preference by holding the Alt and Shift keys when you open Lightroom.  

A popup window will ask if you want to reset your preferences. 

6. Uninstall and Reinstall Lightroom:  If during the installation of an update you have problems, then uninstall and reinstall 

the update using the steps outlined below: 

 Reboot the computer. 

 Uninstall Lightroom Classic. 

 Reboot the computer. 

 Reinstall Lightroom Classic using the Adobe Creative Cloud app (or Lightroom 1-6 using your original disk). 

 Reboot the computer. 

7. Try a new catalog:  If resetting the preferences doesn’t help, create a new catalog to rule out minor catalog corruption.  

This is only a test to check whether there is a problem with the catalog.  Don’t delete your working catalog or start 

working in new temporary catalog.  The procedure for doing this follows: 

 Go to File>New Catalog. 

 If you can’t open Lightroom to access the menu bar, hold down the Ctrl key while restarting Lightroom, then click the 

Create New Catalog button. 

 Choose a location for the temporary catalog such as the desktop. 

 Import some photos into this new catalog to check everything is working as expected. 

 If this works, the problem is likely specific to your catalog.  Don’t panic, that can usually  be fixed.  Do the following to 

fix the catalog: 

o Restore from backup:  Copy one of the backed-up catalogues over the damaged one. 
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o You can find your backup Catalogs by choosing in the menu bar Edit>Catalog Settings.  Then in the popup 

window select the General tab and depress the Show button. 

 To return to your normal catalog, go to File>Open Recent. 

8. Rule out corrupted presets & fonts:  

 Do the following for corrupted presets in a Windows operating system: 

 Go to Edit menu>Preferences>Presets tab.  Press the Show Lightroom Develop Presets button. 

 Close Lightroom before going to the next steps. 

 Select the contents the Lightroom Presets folder. 

 Move the subfolders (e.g. :Lightroom Develop Presets, etc.) to another location, such as the desktop. 

 Restart Lightroom. 

 Do the following for corrupted fonts:  Corrupted fonts have also been known to cause problems, particularly in the 

Print and Book modules. Fonts aren’t specific to Lightroom. If you’re not familiar with managing your operating 

system’s fonts, Google ―uninstall font‖ and the name of your operating system for instructions on removing fonts. 

9. Check for hardware and operating system problems: 

 Damaged RAM can also cause some odd problems  You can check for damaged RAM by running MemTest software 

(https://www.memtest86.com/download.htm ) 

 For intermittent problems, check your hard drives.  Your hard drive could be dying or running low on space.   

 If the screen is behaving oddly, check your graphics card, monitor and calibration. 

 If you’re having problems importing, check your card reader, USB ports and the destination hard drive. 

 Check your boot drive to ensure it has plenty of space available, as a lack of space for operating system temp files 

can cause all sorts of problems. 

10. Get help:  You can post a question on Lightroom Queen Forum (https://www.lightroomqueen.com/community/ ) and 

she will try to help you figure out a solution.  Also you can call or chat with an Adobe technician 

(https://www.adobe.com/about-adobe/contact.html). 

Internet Connectivity — Offline Grace Period, and Reminders: 

 You can avoid losing access to the Adobe applications by making sure you are online at least every thirty days.  If you 

are traveling without Internet access (or with very limited access), it’s a good idea to get online and launch one of the 

Adobe applications to make sure everything is working properly before your trip. 

 The apps attempt to validate your software license every 30 days.  You will receive a reminder to reconnect to the 

Internet to validate your license if the 30-day clock has expired. 

 If you are on an annual plan, billed monthly you can go up to one calendar month+99 days.  Month-to-month 

subscription members get 30 days of grace period. 

 Specific details for off-line use follow: 

 After one calendar month, a dialog box requests online connection. 

 You can dismiss the dialog box; the next reminder shows up after 30 days. 

 After one calendar month + 69 days, the dialog box appears daily. 

 After one calendar month + 99 days, one final offline product launch is available. 

LIGHTROOM (cloud base desktop app) ADJUSTMENT WORKFLOW 

I have a lengthy Lightroom adjustment workflow PDF file that I can email to you if you are interested.  The article is for RCC 

members only who are in good standing.  Email me your request at:  jhwr@earthlink.net. 
 

https://www.memtest86.com/download.htm
https://www.lightroomqueen.com/community/
https://www.adobe.com/about-adobe/contact.html
mailto:jhwr@earthlink.net
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RCC Photo Blog – Stan Fry 

 
Redlands Camera Club Group Members Only 

Are you a member of the Redlands Camera Club? Come and join our new 

Members Only group where you can share images, tips, tricks, offer support or 

insights, ask questions and interact with other members without all the other 

distractions of an open group. Please read the rules and you must be a 

Redlands Camera Club member to join! 

We are up to 70 users and almost 1,100 images on the RCC Photo Blog.  

If you do not already have an account,send an e-mail to signup@rccphotoblog.com and we will get you set up. 

The blog is a great place to get input on your images. Other Members’ images can help you find some inspiration 

(and perhaps some motivation). 

We are working on the image color issue for some images.  When images are submitted they are resized to fit 

different screens.  In this process, they are desaturated a bit.  We don’t know the cause of the problem yet, but are 

working on a solution. 

 

I got tired of sifting through photography sites and blogs trying to find useful learning material.  In response, I 

created pbdigest.com – a curated (sort of) collection of photography articles from over 100 photography blogs.  

Given that this site helps me keep track of useful learning resources, I though club members may benefit too.  I 

would also be interested in any feedback you might have.  Thanks for taking a look and I hope the site is helpful to 

you. 

 

 

 

 

 

 

 
Photo 

by 

Judith Sparhawk 

 

 

 

 

https://www.facebook.com/groups/2521924061368053/?__xts__%5B0%5D=68.ARCMAALkoRBiKV1gSiQlz6tIFwP9hhA0vDx7b_cNQPtCWsrnFMzm43yvMG4XGCLGF8UwN6ingQLl8pIRVLlFRKC-t81BV15gmBA8fWuptNsT85AI8BJu5BBvlHdKIOPq2ehadlUiqXAE25HwAqNDrKmKcreKuQkyCDhfU2Um_PIjoNfzm-yMmxlb27M_n1MbD0VOrODP5y4kS-ZhpNbY2LxPmu3_rYsXSOvN0WdeXQl7Q-2T7MzbQ_OLg2lLhCYKDuqHemuPluGDQDo-X5EDmnmwkePxpl6cQa4AZrRYCNuceCLnaXdyOfA-jhJQJgHljsQCnUyWfkuT29YQzMFPQQcc4w&__tn__=HH-R
http://www.pbdigest.com/
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Announcements 
 

New – Personal Lightroom Coaching with John Williams 
 

Contact John Williams for some over-the-shoulder coaching in photo editing, a great way to learn. Using 

your selected images, John will work with you at your level to improve your understanding of key tools and 

techniques to make the most of your photos. John is a regular contributor of articles on Lightroom and 

Photoshop to the RCC Photogram. Reach John at jhwr@earthlink.net or talk to him at our meetings.  

 

RCC Members: Unique opportunity to make a difference 
Frank Peele, Education/Workshops Chair 

Museum of Redlands 

This newly-established museum needs quality photography of items in its collection, and has asked RCC 

for support. This sounds like a win-win situation, both for the museum and for our members who want 

to develop skills in ―product‖ photography. I envision a workshop to teach the fundamentals, and one or 

more shooting sessions to get into creating great images for the museum’s use. If you’re interested in 

being part of this service to the community, or just want to find out more about the opportunity, shoot 

me an email: educationworkshopsrcc@gmail.com  Thanks, Frank 

____________________________________________________________________________________________________________ 

Film cameras and Lenses Needed  
 
A group of photo-enthusiasts at Riverside Community College needs FILM cameras and lenses to use in 

their studies. If you have such equipment you’re willing to donate to a worthy cause, please contact RCC 

member Constance St Jean and let her know what you have. Contact her by email at 
constancestjean@gmail.com 

_________________________________________________________________________________________________________________ 
 

 

 

 

 

 
Photo 

by 
Russell Trozera 

 

 

 

 

 

 

 

 

 

 

mailto:jhwr@earthlink.net
mailto:educationworkshopsrcc@gmail.com
mailto:constancestjean@gmail.com
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Alabama Hills, Mt. Whitney & Bristlecone Pines Photo Workshop 
 

Renowned Photographer Bob Fletcher would like to invite you to participate in his ―Alabama Hills, Mt. Whitney & 

Bristlecone Pines Photo Workshop‖. 

 

Bob will give a 20% discount to any Redlands Camera Club members who sign up for this workshop.  

 

To receive your discount, be sure and let Bob know at sign up that you are a RCC member. 

 

Alabama Hills, Mt. Whitney and Bristlecone Pines Workshop 

September 13 – 17, 2019 

4 day workshop 

Cost: $695 (if you are a member of Redlands Camera Club, you receive a 20% discount) 

What is there to photograph? 

 

• Arches, lots and lots of arches 

• Trout stream and Pond 

• Sunrise and Sunset 

• Mt. Whitney waterfall 

• Night sky: the Milky Way and Star Trails are excellent this time of year 

• 4,000 year old Bristlecone Pine trees 

• and so much more 

 

E-mail Robert Fletcher at rrfletcher@gmail.com  to reserve your 

spot 

 

 

 

 

 

 

 

 

 

 

 

mailto:rrfletcher@gmail.com
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For Sale 

 

For Sale: New in Box Tascam DR-60D Digital Audio Recorder  

 

Want to greatly improve the audio quality of videos made with your DSLR, Mirrorless or other digital camera? 

Tascam, the professional division of Teac Audio, has your solution – the 

DR-60D 4-channel audio recorder. Built to mount under your camera 

either on or off a tripod, this recorder offers 2 professional balanced XLR 

or ¼‖ TRS mic inputs plus a 3.5 mm stereo mic input. Its many modes 

allow you to capture very high-quality sound, tailor the sound to your 

preferences, and use microphones of widely different types. The LCD 

screen is fully visible in any lighting condition (even direct sunlight), and 

complete controls put you in charge of your recordings. In addition to its 

potential for recording audio for video, its many capabilities make it an 

excellent choice for any high-quality audio recording – music, voice you-

name-it. Unit is in original box, has never been used, and comes with all included accessories. Sells on Amazon for 

$179; priced for quick sale at $119.  

 

Frank Peele, 909.798.7999, or email to FrankPeele@verizon.net. 

 
 
 
 
 
 
 
 
 

 
 

Photo 
by 

Rick Strobaugh 
 

mailto:FrankPeele@verizon.net
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Redlands Camera Club    P.O. Box 7261 Redlands, CA 92375 

www.RedlandsCameraClub.com 

Officers (2017-2018) 

President:  Dave Ficke - Vice President/Programs: Russell Trozera - Secretary:  Deborah Seibly 

Treasurer:  Rick Strobaugh - Past President:  Carl Detrow -  

Chairs (2017-2018) 

 Competition:  Carl Detrow - Education/Workshops:  Frank Peele  Facebook/Blog:  Stan Fry - 

Field Trips:  Mary Ann Ponder  

Historian:  Bruce Bonnett - Hospitality/Events:  Lucy McGee - Librarian: Michael Graves  

Membership:  Stephanie Billings - Mentor:  Rick Strobaugh - Photogram:  Debra Dorothy        

Publicity: Stan Fry - S4C:  Deborah Seibly - Color Munki: Carl Detrow 

Webmaster: Wayne (Woody) Wood –Debra Dorothy -  Welcome:  Stephanie Billings 
 

 

 

Photogram Editor – Debra Dorothy 

 
A Note from The Photogram Editor 

 

The theme for the September Photogram is ―Photo Journalism‖.  Send me pictures of your 

Sporting Events, Natural Disasters, Street Photography, Festivals and more to include in the 

next photogram. 

 
 

mailto:debbiedsd.dorothy@gmail.com 

 

 
 

                                                                                            
 
 

Photo 
by 

Debra Dorothy 
 

 

 

 

 

http://www.redlandscameraclub.com/
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